Copyright, Trademark, and License Acknowledgments
Portions of the BioQUEST Library are copyrighted by Annenberg/CPB, Apple Computer Inc., Beloit College, Claris Corporation, Microsoft Corporation, and the authors of individually titled modules. All rights reserved. System 6, System 7, System 8, Mac OS 8, Finder, and SimpleText are trademarks of Apple Computer, Incorporated. HyperCard and HyperTalk, MultiFinder, QuickTime, Apple, Mac, Macintosh, Power Macintosh, LaserWriter, ImageWriter, and the Apple logo are registered trademarks of Apple Computer, Incorporated. Claris and HyperCard Player 2.1 are registered trademarks of Claris Corporation. Extend is a trademark of Imagine That, Incorporated. Adobe, Acrobat, and PageMaker are trademarks of Adobe Systems Incorporated. Microsoft, Windows, MS-DOS, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation. Helvetica, Times, and Palatino are registered trademarks of Linotype-Hell. The BioQUEST Library and BioQUEST Curriculum Consortium are trademarks of Beloit College. Each BioQUEST module is a trademark of its respective institutions/authors. All other company and product names are trademarks or registered trademarks of their respective owners. Portions of some modules' software were created using Extender GrafPak™ by Invention Software Corporation. Some modules' software use the BioQUEST Toolkit licensed from Project BioQUEST.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE OF CONTENTS</td>
<td>V</td>
</tr>
<tr>
<td>PREFACE</td>
<td>1</td>
</tr>
<tr>
<td>ACKNOWLEDGMENTS</td>
<td>3</td>
</tr>
<tr>
<td>AN OVERVIEW OF EPIDEMIOLOGY</td>
<td>4</td>
</tr>
<tr>
<td>WHAT YOU SHOULD READ</td>
<td>5</td>
</tr>
<tr>
<td>WHAT YOU NEED TO KNOW</td>
<td>6</td>
</tr>
<tr>
<td>USING EPIDEMIOLOGY</td>
<td>7</td>
</tr>
<tr>
<td>Running <em>Epidemiology</em></td>
<td>7</td>
</tr>
<tr>
<td>Opening a Problem</td>
<td>7</td>
</tr>
<tr>
<td>Setting up a Simulation</td>
<td>7</td>
</tr>
<tr>
<td>Running a Simulation</td>
<td>11</td>
</tr>
<tr>
<td>Viewing Results</td>
<td>12</td>
</tr>
<tr>
<td>Organizing Data and Reporting Results</td>
<td>13</td>
</tr>
<tr>
<td>Saving and Opening Problems</td>
<td>14</td>
</tr>
<tr>
<td>Quitting</td>
<td>15</td>
</tr>
<tr>
<td>MENUS AND COMMANDS</td>
<td>16</td>
</tr>
<tr>
<td>File Menu</td>
<td>16</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>18</td>
</tr>
<tr>
<td>Control Menu</td>
<td>19</td>
</tr>
<tr>
<td>Settings Menu</td>
<td>22</td>
</tr>
<tr>
<td>Marks Menu</td>
<td>23</td>
</tr>
<tr>
<td>Windows Menu</td>
<td>24</td>
</tr>
<tr>
<td>GLOSSARY</td>
<td>28</td>
</tr>
</tbody>
</table>
Preface

Ebola breaks out in Zaire. The Hot Zone describes a close call with Ebola in Reston, Virginia. The movie, Outbreak, depicts a fictional hemorrhagic fever outbreak in the U. S. The AIDS pandemic is gaining steam in many parts of the world. Given the threats from emerging diseases and concerns over the resurgence of older diseases, exacerbated by the prospects for global climatic change and the evolution of drug-resistant pathogens, the threat of global pandemics seems to have replaced nuclear war as this generation’s Armageddon.

One way to explore these issues in the classroom is to construct and explore models. Epidemiology is a computer model that simulates the spread of an infectious disease through a population. This program allows users to graphically enter population and disease characteristics (e.g., the virulence of the pathogen, the likelihood of transmission, etc.), to set up an initial population, and then observe the changes in population characteristics and the prevalence of the disease through time. Using modified SIR-type models (Susceptible-Infected-Recovered), Epidemiology allows students to ask a variety of “what if?” questions, to design and perform their own investigations, and to explore the implications of various public health policies. The direct-manipulation, graphical interface encourages exploration, and makes the program accessible to introductory students. Nevertheless, the simulation model is capable of addressing problems that even graduate students in population biology or public health should find interesting and challenging.

Epidemiology was developed by the Biology Software Lab at the University of Oregon as part of a curriculum project called Workshop Biology, an innovative approach to teaching introductory biology to non-majors. As with our Workshop Biology course in general, Epidemiology is designed to help accomplish three broad goals: (1) to help students understand difficult concepts by inviting them to challenge misconceptions and preconceived notions, (2) to get students involved in their own scientific investigations, and (3) to help them make connections between important scientific ideas and methods and crucial issues of public policy and personal well-being.

To accomplish these objectives, we are developing a teaching module (Appendix 4) that begins with very structured activities that address important concepts, and moves toward open-ended investigations that relate to public policy (see Sample Teaching Module). These activities provide a starting point for instructors interested in using Epidemiology in their classes and labs. The module is in an early stage of development, and does not take full advantage of the features and flexibility of the program. Whether you choose to adopt this module, or to adapt it to your setting, or to build a module of your own, we would like to know how you are using the program.

Epidemiology is still evolving. New features and interface changes will occur over time. We are quite anxious to hear your views of Epidemiology and of the teaching module. We would greatly appreciate any suggestions for improvement, including ideas about the incorporation of new features.
For more information about Workshop Biology, contact:

Daniel Udovic  
Director, Workshop Biology Project  
Department of Biology  
1210 University of Oregon  
Eugene, OR 97403-1210

phone: 541-346-5092  
internet: udovic@oregon.uoregon.edu

or see the Workshop Biology home page on the World Wide Web:

http://Biology.uoregon.edu/Biology_WWW/Workshop_biol/wb.html
Acknowledgments

Workshop Biology has been developed through grants from the Department of Education (FIPSE) (P116A1-0385 and P116A4-1049) and the National Science Foundation (USE-9150760 and DUE-9455145). These grants, plus a grant from the Howard Hughes Medical Institute, have supported the development of Epidemiology and related materials.

We would like to thank those faculty and students who have tested earlier versions of Epidemiology for their feedback and support, and G. Z. Brown and his co-workers for stimulating discussions regarding program design.

Our colleagues, Gordon Hennesy and Jasper Barber contributed numerous ideas during the development of Epidemiology. They are also responsible for many aspects of the common interface design of BSL programs.

The staff of the Workshop Biology Project, John Postlethwait, Alan Dickman, Peter Wetherwax, Deborah Morris, Stacey Kiser, and Nan Perigo, and participants in our Biology Education Journal Club over the past several years have contributed many ideas about teaching and learning that have influenced our software tools and the curricular materials that use these tools.

Finally, we’d like to thank the staff of the BioQUEST Consortium for their continued support of our development efforts.
An Overview of Epidemiology

Are emerging diseases, like Ebola, a serious threat to the world population? Under what conditions would we expect a new infectious disease to spread through a population? Can we predict whether a specific vaccination policy or other public health policy will be effective in preventing the spread of a disease?

These are a small sample of the kinds of questions that can be addressed by Epidemiology, a computer program that simulates the spread of a disease in a population. By manipulating values such as population death rates, birth rates, the length of time infected individuals are infectious, the probability of disease transmission, and initial population characteristics, and then using the simulation to see how population characteristics change through time, users of Epidemiology can investigate important questions in population biology and public health, develop a deeper understanding of fundamental population concepts, and explore issues related to public health policy.

A key feature of Epidemiology is the easy-to-use interface that allows you to rapidly and intuitively alter population characteristics, even while a simulation is running, and to instantaneously see the effects of your alterations. For example, changing the probability of disease transmission can be done quickly and easily, and if the simulation is running, you will immediately see the effect of your changes on the spread of the disease.

Epidemiology is designed to make it easy for you to creatively explore and experiment. Just as importantly, it is designed to help you organize your explorations and keep track of your experiments. You may stop a simulation at any time and mark your place so that you can return to it later to make comparisons, to perform controlled experiments, or simply to refresh your memory.

We hope that you find Epidemiology to be an interesting and productive way to learn about the population dynamics of disease. In any case, we would like to hear from you (both students and faculty) about your experiences with the program. We are particularly interested in knowing the kinds of issues that you have explored, how Epidemiology helped, and what kinds of limitations or problems you encountered. Please write to the Biology Software Lab, send us e-mail (BSL@oregon.uoregon.edu), or provide feedback through our World Wide Web site -- http://Biology.uoregon.edu/Biology_WWW/bsl/bsl.html.
What You Should Read

If you are unfamiliar with the Macintosh computer or computer terminology used in this manual.

Read the next section: What You Need to Know (see page 6).

If you are unfamiliar with a biological term that is used in this manual

Look in the section entitled: Glossary (page 28).

If you want to know whether you have the right equipment to run the Epidemiology program.

Read Appendix I: Hardware and software requirements (page 30).

If you are familiar with the Macintosh but not with Epidemiology.

Read the section entitled: Using {Pital} (page 7).

If you have been through the features and want to know more details.

Read the section entitled: Menus and Commands (page 16).

If you are an instructor, and want to know how to use the program to prepare problem sets for students.

Read Appendix III: Notes for Instructors (page 32)
Also see Appendix IV: A Sample Learning Module (page 36).

If you’ve read through the manual, but have found something that doesn’t seem to work in Epidemiology.

Read Appendix II: IT DOESN’T WORK! (page 31).
What you Need to Know

Throughout this manual, we will assume that you are already familiar with basic Macintosh operations and concepts. If you are not comfortable with these, refer to the *Macintosh Owner’s Guide* or some other introduction to the Macintosh before starting. To help you on your way, the following is a list of Macintosh concepts you will need to understand, along with a brief explanation. For more information, consult one of the references mentioned above or simply ask someone who has worked with a Macintosh before to explain briefly.

- **Pointing.** Pointing simply refers to positioning the cursor, which is shaped like a pointer, over some object.

- **Clicking.** Also known as *single-clicking*. Position the cursor over the desired object and click the mouse button once. For example, “Single click in a window to activate it” means that if you position the cursor over a window and click once, it will become the active window. Clicking objects is typically used to *select* them (see below).

- **Double-clicking.** Just like single-clicking except that you click the mouse button *twice*, in rapid succession, instead of just once.

- **Dragging.** This is used to move objects around on the screen. To drag an object, “grab” the object by pointing to it and depressing the mouse button. Don’t click the button! Depress it and hold it down. Now move the mouse — the object is dragged around on the screen. When you have positioned the object where you want it, release the mouse button to “drop” the object.

- **Selecting.** This operation is used to pick one or more objects from a group of objects. Selecting is usually accomplished by clicking on the object to be selected. Typically, selected objects will become highlighted to indicate they have been selected. Example: “Select the mortality value for ages 20-25 by clicking on it.”

The concepts listed above are few, but are central to the operation of almost any Macintosh program. There are a number of less fundamental concepts which we will ignore or will introduce as we encounter them.
Using Epidemiology

This section provides basic information on how to use *Epidemiology*. The exercises in the sample teaching module illustrate ways to use the program as a learning tool. In this section we describe how to start the program, open files, enter population data (either graphically or in spreadsheet format), run simulations, organize your findings, save your simulations in a file, and quit the program.

**Running Epidemiology**

In order to run *Epidemiology*, first make sure it is installed on your computer's hard disk, or on a floppy disk that you have inserted into the disk drive. Make sure that you also have all the problem files that you will need (if any — check with your instructor to find out what they are called).

Find the icon for the Epidemiology application and double-click on it. The program will start up.

**Opening a Problem**

You may simply start using the program directly, or you may want to open a problem file with pre-set values (e.g., if your instructor has made one available, or you have previously saved your work). To open a problem file, choose the Open command from the File menu. (If it is “grayed out” it means you already have a file open, so you must close it before opening a new one. To close the file, choose the Close command from the File menu). You will see a window with names of different files. Find the problem file name and click on it to select it, then click on the button marked Open (or double-click on the problem file name). The program will begin opening the windows of the problem file.

**Setting up a Simulation**

**Interpreting the Flow Chart**

The population characteristics that influence population growth and the spread of a disease in the population are summarized in graphical form in the flow chart window. The flow chart gives a graphical depiction of the way that the models underlying *Epidemiology* work. The host population is broken down into several categories. In the flow chart depicted in Figure 1, for example, the categories are “Susceptible”, “Infected”, and “Recovered”. In this case, “infected” implies infectious, and “recovered” implies immune to further infection.
The simulation model keeps track of the number of individuals in each category and describes the rate individuals enter and leave each category. For example, new individuals enter the “Susceptible” category via birth. Individuals may also move from the “Recovered” category into the “Susceptible” category. This would represent individuals who had the disease, but are now losing their immunity and hence becoming susceptible to infection again. Individuals can leave the susceptible category in two ways, through death or through infection. In the latter case, they enter the “infected” category.

Values for factors such as the birth rates, death rates, disease transmission rates, rates of recovery, etc. can be viewed by clicking on the appropriate button on the flow chart. For example, clicking on the icon on the arrow next to “birth rate” brings up a dialog box indicating the current setting of the birth rate (Figure 1). The user can change these values at any time, even when the simulation is running.

Epidemiology assumes that individuals can die from the disease (disease death rate) or from other causes (natural or “background” death rate). Individuals in all categories (including those showing symptoms of the disease) may die from other causes, but only individuals showing symptoms will die from the disease.
Manipulating Population Characteristics

The values for factors that influence population growth and the spread of the disease may be changed by clicking on the appropriate buttons or pop-up menus on the flow chart. This may be done even when the simulation is running (if running, the simulation will temporarily stop while you make changes, and then start up again).

Disease transmission is the most difficult aspect of the model. Clicking on the button near the arrow going from susceptible to infected brings up a dialog box that allows the user to view or alter the parameters determining disease transmission (Figure 2). The rate at which susceptible individuals become infected depends on the probability of transmission given contact between a susceptible individual and an infected individual, and on the rate at which individuals come into contact.

*Epidemiology* 2.5 allows users to choose between density-independent and density-dependent models of contact rate. In the density-independent model, the average number of contacts in a time interval does not depend on the density or size of the population. This might be the case for sexually transmitted diseases in populations where the average number of sexual partners is not influenced by the size of the population. In the density-dependent model, the average number of contacts made by an individual during a time interval depends (in a linear way) on population size. This might be the case, for example, for airborne diseases like colds, flu or measles.

![Figure 2. The “Transmission Parameters” dialog box allows you to change factors that influence the rate at which susceptible individuals become infected. You may change the probability of transmission given contact, and you can choose between two models of how the rate of contact changes with density. The “disease introduction” feature allows users allows immigration of infected individuals into the population.](image)

The size of the population in each of the model categories may be altered by choosing “Current State...” from the Settings menu. This may be done at the beginning of a simulation, or at any time during a simulation, even when it is running.


Defining a Model

To choose the type of model users can select the "Define Model..." command from the Settings menu. For example, if you wish to model a disease in which there is an asymptomatic stage when an individual is first infected (as with AIDS or rabies), one can choose the appropriate check box from the “Define Model...” dialog box (Figure 3). A new flow chart will appear reflecting your choices. The model choices available allow you to use Epidemiology to study the dynamics of a large variety of diseases. In Epidemiology 2.5, you may also choose to model infectious diseases that are transmitted by vectors (e.g., mosquitoes, fleas), or that affect other populations (reservoir populations) besides the host (e.g., rats, monkeys). If you choose to include vectors and/or reservoir populations in your models, you will see separate flow charts for each population.

Warning: changing these parameters during the run will cause the run to start over from the beginning time interval, so only change these parameters before you begin a simulation, or when you are ready to start a new one.

![Figure 3. The “Model Definition” dialog box allows you to select from among various model types. Some check boxes are always selected and are grayed out. These are not under user control. For example, if you choose to have a vector population, it will have at least two categories, susceptible and infected. Your only choice will be whether to have a latent category or not.](image)

The Model Definition dialog box allows user to control the level of complexity that they will see in the flow chart and simulation runs. The basic model divides the host population into only three categories (Susceptible, Infected, and Recovered). By choosing the appropriate settings, the user may add categories for immunized individuals, and may subdivide the infected population into the following categories:

1. **latent** (i.e., asymptomatic (healthy) and not yet infectious, as in rabies before the onset of symptoms,

2. **asymptomatic and infectious** (e.g., HIV+, but not suffering from AIDS), and

3. **symptomatic and infectious** (e.g., individuals with AIDS, influenza, etc.)

A fourth possibility, not currently included as an option, would be individuals who still show symptoms of the disease, but are no longer infectious.
Demography 2.5 allows users to model the dynamics of vector populations and reservoir populations as well as the dynamics of the host population (Figure 4). Vectors are species that carry the disease organism from one host to another. Often these are biting insects or other ectoparasites (e.g., mosquitoes or fleas). Reservoirs are species that are also affected by the disease organism. They are called reservoirs because they are a source for the disease, even when it is rare or absent from the host population. For example, rats are a reservoir for plague and many birds and mammals serve as reservoirs for lyme disease. Some diseases (e.g., plague) involve both reservoir and host populations.

![Vector Flow Chart](image)

Figure 4. The flow chart for a vector population. Individuals are either susceptible (non-transmitters) or infectious (transmitters).

When vectors and or reservoir populations are included in a model, the parameters involved in disease transmission become more complex. Parameters determining transmission from vector or reservoir to the host population can be accessed from the vector or reservoir flow charts, respectively, by clicking on the button near the arrows going from susceptible to infectious.

Keep in mind that direct transmission from host to host can be occurring at the same time. Parameters controlling direct transmission are still available from the host flow chart. If you are modelling a disease in which direct transmission does not occur (e.g., malaria, at least before blood transfusions), then you can set the probability of (direct) transmission to zero.

**Variable Settings**

By choosing the "Current State..." command from the Settings menu, users can modify the values for the initial time and for the current population size. For example, if you wanted to model bubonic plague in Medieval and Renaissance Europe, you might want to set initial time to 1300, the susceptible population size to about 75 million, the infected population to just a few individuals, and the recovered population to 0.

**Running a Simulation**

![Control Panel Buttons](image)

Figure 5. The Control Panel buttons can be used to control the running of the simulation. From left to right, the buttons are "Stop", "Go", "Step", and "Reset". These commands are also available from the Control menu.
Once you have set up the simulation, you can use the commands under the Control menu or the icons on the Control Panel (Figure 5) to see how the population changes through time.

To advance the simulation just one time interval, choose the Step command from the Control menu or the Step icon from the Control Panel.

To have the simulation run until a specified time, or for a specified number of time intervals, choose the Go Until... or Go For... commands from the Control menu.

To have the simulation continue advancing until you tell it to stop, choose the Go command from the Control menu or the Go icon from the Control Panel.

Whenever you want the simulation to stop running, choose the Stop command from the Control menu or the Stop icon from the Control Panel. This only stops the simulation; it doesn’t quit the program, or end the problem you are working on, so don’t worry. You can stop and start the simulation as often as you like.

If you wish to return to the initial state of a simulation, with the fertility, mortality and age distribution graphs as they were before you started the current simulation, choose “Reset...” from the Control menu or the Reset icon from the Control Panel. A dialog box will appear asking whether you wish to mark the current spot before returning to the initial state (see Menus and Commands: Control Menu: Reset... for more details).

The Control Panel is a convenient way to run simulations. Because of limited screen space, however, you may want to hide the Control Panel. You may do so by clicking in the palette’s close box, or by choosing "Hide Control Panel" from the Control menu. If the palette is hidden, you may display it again by choosing "Show Control Panel" from the Control Menu.

**Viewing Results**

Results are displayed in three types of windows: (1) the “Status” window, (2) the Population Size vs Time window, and (3) the “Deaths vs. Time” window. These windows are updated every display interval. If you are using a model with vector populations or reservoir populations enabled, you will be able to view status windows and population windows for each population.

The "Status" window displays the current time and the number of individuals in the total population and in each category. It also indicates whether the simulation is currently running or is stopped. When the simulation is running, the status window is updated each display interval.

The Population Size vs Time” window displays a graph of the number (or proportion) of individuals in different population categories through time. To change from total
numbers to proportions (or back again), click on the “%” icon on the tool bar at the top of the window.

The “Deaths vs. Time” window displays the number of individuals dying each time interval. It displays both the number of “natural” deaths, and the number dying from the disease.

If you watch the above graph of population size or mortality as the simulation runs, you will notice that they automatically re-scale whenever necessary. It may take you several runs to get used to the unexpected sudden changes in the shape of these graphs that occur during re-scaling.

Both of these windows may also be viewed in spreadsheet format. Click on the "table" icon on the tool bar at the top of the window. The graphical display is now replaced by a table. To return to the graphical display, click the "graph" icon on the tool bar at the top of the window.

At times you may want to simplify the Population Size vs. Time window and the Status window by only displaying values for a subset of the available population categories. By choosing the "Display..." command from the “Settings menu, you can select the appropriate subset to display.

**Organizing Data and Reporting Results**

**Marking**

The Mark feature allows you to set a mark at any particular time interval during the run of a simulation. You can enter a meaningful name for the mark, to help you understand/remember why that particular time interval was important. You can then enter notes to keep track of additional information in association with the mark.

When you set a mark, *Epidemiology* saves all the values displayed in the windows, as well as the position of the windows on the screen. This allows you to come back to this point, and even to start the simulation running again from that point, if you wish.

Marks allow you to summarize a simulation run or a set of runs. If you want to show someone what happens to a population at various times, instead of running the simulation and stopping it whenever you want to point something out, you can do the run beforehand, and set a mark at each time interval of interest. This can save a lot of time, especially if the time intervals are far apart, or you need to change fertility, mortality and/or age distribution settings along the way.

WARNING: Because of a bug in *Epidemiology* 2.5, marks are lost whenever a new model type is defined. If you have been working with one type of model for some time and wish to switch to a different type of model, you should save your work, close the file, and open a new file before defining your model type.
Exporting

In preparing reports or handouts, it is often useful to export data or graphs. In *Epidemiology 2.0*, the contents of any window (with the exception of the summary statistics window) can be copied into the clipboard and pasted into other documents. For example, by choosing “Copy” when the “Population Size vs. Time” window is the active window, either the graph or the table (whichever is showing) will be copied onto the clipboard. The table could be pasted into a spreadsheet or into a word processing document. Or the picture of the graph could be pasted into word processing documents or into documents from drawing programs. The contents of the notes windows associated with marks can also be copied and pasted into word processing documents.

Printing

**Sorry! The “Print” option is not yet available.** To print out your results, first copy the contents of any window to the clipboard and then paste them into another document, such as a draw program or a word processor (see the section on “Exporting” above).

You can print out a view of all the data in the windows as they are shown at any time during the run of a simulation.

Choose the Print Setup... command from the File menu to make sure that the printing settings are okay for your printer.

Choose the Print command from the File menu to begin printing. A dialog box will appear allowing you to choose which windows to print and how to arrange them.

Saving and Opening Problems

The Open command under the File menu allows you to open a problem file that has been saved to disk. You can do this only if there is not another problem file already open. If another file is open, the Open command will be inactive (will appear “grayed out” on the screen) when you select the File menu. Save the current file first (if you want to), then choose the Close command from the File menu. Any parameter windows which are displayed will disappear. Now, choose the Open command under the File menu. Notice that the Open command is now available.

The Save command under the File menu allows you to save a problem file, along with any marks that you have set, and any notes you have made for those marks. It will remember the last time interval you reached and the position of all the parameter windows.

The Save As... command under the File menu allows you to save a problem file under a different name from the one you opened. For instance, if you open a class problem file, but you make changes to it and want to save it to a name you choose, you would choose the Save As... command from the File menu. A window will appear, asking you to name the file. Enter in your new name, and click on the SAVE button to save the file.
under your new name. The old file will be the same as it was before, and still have the old name.

**Quitting**

To quit *Epidemiology*, choose the Quit command from the File. If you have made any changes, a dialog box will appear giving you the opportunity to save your work before exiting the program.
Menus and Commands

This section will describe the menu structure of *Epidemiology*, and show you how to use the menus to choose commands to open files, change parameters, set marks, run the simulation, and print results.

**File Menu**

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
</tr>
<tr>
<td>Report to Saved</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
</tr>
<tr>
<td>Quit</td>
<td></td>
</tr>
</tbody>
</table>

**New**

Use the “New” command if you don’t have a file open, and you want to start a new file from scratch. Choose the “New” command from the File menu. All seven *Epidemiology* windows will appear with default parameter values. You are now ready to start making changes to this new file.

**Open**

To open a file, choose the “Open” command from the File menu. A window will appear, asking you the name of the file you want to open, and where on the disk this file is. Click on the file name to select it, then click on the Open button.

The Open command is inactive whenever there is already a file open, and will appear “grayed out”. Close the current file before opening a new one (see Close command, below).

**Close**

Before you open a new file, you must close the file that you currently are using, by choosing the “Close” command from the File menu.
If you have made changes to the current file, and have not saved them, a window will appear, asking whether you want to save the changes. To save the changes to this file, click on the Yes button. To close the current file without saving the changes, click on the No button. To return to using the current file, instead of closing it, click on the Cancel button.

**Save**

To save the file you are currently using, choose the “Save” command from the File menu. A window will appear asking you to choose a name and location for the new file. Type in a new name and click on the OK button.

Caution: if you have opened a file, made changes to it, and you want to save these changes to your own file, but don’t want to change the original file, use the “Save As...” command instead.

**Save As...**

To save the file you are currently using under a different name, choose the “Save As...” command from the File menu. A window will appear asking you to choose a name and location for the new file. Type in a new name and click on the OK button. The old file will not be affected.

**Page Setup...**

Sorry! The “Page Setup...” option is not yet available.

The “Page Setup...” command from the File menu displays a window which shows the current page setup for the printer. Choose this command before you choose the Print command to ensure the page setup is the way you want it.

**Print**

Sorry! The “Print” option is not yet available. To print out your results, first copy the contents of any window to the clipboard and then paste them into another document, such as a draw program or a word processor (see the “Copy” and “Paste” commands under the Edit menu).

After you have checked the page setup for your printer with the “Page Setup...” command, choose the “Print” command from the File menu to print a view of the windows from Epidemiology in their current state. A dialog box will appear asking you to select the windows that you wish to print and how you want them arranged. Once you have made your selections, click "OK". The standard Macintosh print dialog box will appear. Choose the appropriate settings and click "OK" to print your document.
Quit

To quit Epidemiology, choose the “Quit” command from the File menu. If you have not saved the file, a window will appear, asking if you want to save the file. All windows will disappear and the program will end.

Edit Menu

<table>
<thead>
<tr>
<th>Edit</th>
<th>Control</th>
<th>Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>%Z</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>%H</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>%C</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>%U</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Show Clipboard

Undo

Sorry! The “Undo” option is not yet available.

To “undo” the most recent change to the model (either a change in the shape of a graph, or the running of a simulation), choose the “Undo” command from the Edit menu. You can only undo your last change (see also “Reset” and “Reset All” under the Control menu).

Cut

Use the “Cut” command from the Edit menu when you wish to cut selected text from the Notes window associated with a mark (see the Marks menu). The selected text will be removed from the notes and placed on the clipboard for pasting somewhere else.

The “Cut” command is only active when the Notes window is active and some text has been selected.

Copy

Use the “Copy” command from the Edit menu to copy objects and place them on the clipboard for pasting into other documents. “Copy” takes the visible object from the currently active window (a graph, a table, or the selected text) and places it on the clipboard. Graphs are handled as “picts”, and tables are handled as tab-delimited text.
Paste

Use the “Paste” command from the Edit menu to take text from the clipboard and paste it into a Notes window associated with a mark (see the Marks menu).

The “Paste” command is only active when the cursor is positioned within an active Notes window and there is text on the clipboard.

Clear

Use the “Clear” command from the Edit to delete selected text from the Notes window associated with a mark (see the Marks menu). The selected text will be removed from the notes. It will not be placed on the clipboard.

The “Clear” command is only active when the Notes window is active and some text has been selected.

Show/Hide Clipboard

The “Show/Hide Clipboard” command from the Edit menu presents or hides a window which displays the current contents of the Macintosh clipboard.

Control Menu

Go Until...

To run a simulation until a specified time period, choose the “Go Until...” command from the Control menu. A hierarchical menu will appear, giving you several choices for ending times. If you wish to specify a number that doesn’t appear in the menu, choose “Custom...”. A dialog box will appear asking you to specify the ending time. The simulation will run until it reaches the time period you specify, and then stop automatically.

The “Go Until...” command is inactive except when the simulation is stopped, and will appear “grayed out” whenever the simulation is running.
Go For...

To run a simulation for a specified number of time intervals, choose the “Go For...” command from the Control menu. A hierarchical menu will appear, giving you several choices for the number of time intervals to run the simulation. If you wish to specify a number that doesn’t appear in the menu, choose “Custom...”. A dialog box will appear asking you to enter the number of intervals. The simulation will run for the number of intervals you specify, and then stop automatically.

The “Go For...” command is inactive except when the simulation is stopped, and will appear “grayed out” whenever the simulation is running.

Go

To start the simulation running, choose the “Go” command from the Control menu. The simulation will continue running and the display windows will continue updating until you stop the simulation using the Stop command.

The “Go” command is inactive except when the simulation is stopped, and will appear “grayed out” whenever the simulation is running.

Step

To run the simulation for only one time interval, choose the “Step” command from the Control menu. The simulation will update all the display windows for only one time interval, then the simulation will stop. You can continue the run of the simulation from this point by choosing the Go command, or you can continue to choose the Step command as many times as you want. Each time it will update the simulation for one time interval.

The “Step” command is always active. If you choose this command while the simulation is running, the simulation will immediately stop and then step through one more interval.
Stop

After you choose the “Go” command, the simulation will continue running, and the display windows will continue updating, until you stop the simulation. Choose the “Stop” command from the Control menu.

The “Stop” command is inactive and will appear “grayed out” whenever the simulation is stopped.

Reset

After you start Epidemiology, but before you have run the simulation by selecting the “Go” or “Step” commands, you can set the “initial state” for the run of the simulation. At any time you are running the simulation, you may want to return to this “initial state”.

The “Reset” command from the Control menu (or the Reset button on the Control panel) will set the population size and age distribution back to their initial values. It does not, however, change the fertility or mortality settings.

After choosing “Reset” a window will appear, asking you whether you want to save the current state, before returning to the “initial state”. If you click “Save”, you will be setting a mark (see the Mark menu), and you will be asked to give it a name.

Reset All

The “Reset All” command from the Control menu is similar to “Reset”. In addition to resetting the population size and age distribution, however, “Reset All” resets all the parameter values (e.g., birth and death rates and transmission probabilities) to the values selected before you ran the last simulation the simulation.

After choosing “Reset All” a window will appear, asking you whether you want to save the current state, before returning to the “initial state”. If you click “Save”, you will be setting a mark (see the Mark menu), and you will be asked to give it a name.

Show/Hide Control Panel

The "Control Panel" is a window that contains four "buttons", one for each of the four commands above (Stop, Go, Step, and Reset). The control panel provides an easy and convenient way to run simulations. It always appears in front of other Epidemiology windows.

Occasionally, you might find it useful to hide the control panel. You may do this either by clicking in the panel’s close box or by choosing “Hide Control Panel” from the Control menu. When the panel is hidden you may choose “Show Control Panel” from the Control menu to bring it back into view.
Settings Menu

<table>
<thead>
<tr>
<th>Settings</th>
<th>Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current State...</td>
<td></td>
</tr>
<tr>
<td>Display...</td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Define Model...</td>
<td></td>
</tr>
<tr>
<td>Font Size</td>
<td></td>
</tr>
</tbody>
</table>

Current State...

Choose "Current State..." from the Settings menu to set the starting time of a simulation or to alter the current size for any population category. A dialog box will appear with boxes to enter the appropriate numbers. The starting time can only be changed at the beginning of a simulation.

Display...

Choose the "Display..." command from the Settings menu to select the values to be displayed in the "Status" window and in the Population Size vs. Time window.

Model

Choosing “Model” from the Settings menu brings up a hierarchical menu, with options to bring up dialog boxes or windows for the various factors that influence the model. These options can also be selected by clicking on the appropriate buttons in the Flow Chart window (see pages 7 and 25 for more details on the Flow Chart window).

Define Model...

Choose the “Define Model...” command from the Settings menu to choose the kind of model that you wish to explore, and to set values for certain settings that cannot be changed in the middle of a simulation. A dialog box will appear allowing you to choose.

The Model Definition dialog box allows user to control the level of complexity that they will see in the flow chart and simulation runs. The basic model divides the host population into only three categories (Susceptible, Infected, and Recovered). By choosing the appropriate settings, the user may add categories for immunized individuals, and may subdivide the infected population into several categories (see page 10, “Defining a Model” for more details).
Fonts

Sorry! The Fonts option is not yet available.

Choose the “Fonts” command if you wish to change font sizes (e.g., for presentations). It is a good idea to size the window you’re looking at to take up the whole screen if you increase font size. Otherwise the graph may appear crowded and hard to read.

Marks Menu

<table>
<thead>
<tr>
<th>Marks</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set...</td>
<td></td>
</tr>
<tr>
<td>Go To</td>
<td></td>
</tr>
<tr>
<td>Remove</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
</tbody>
</table>

Set...

To set a mark, place the cursor over the Marks menu, press the mouse button and drag down until the “Set...” command is highlighted, then release the mouse button. A dialog box will appear with the text “Please enter a name for the mark:” A name will already be there: “Mark at time:5”, for example (where 5 would be the 5th year in the run of the simulation). You may move your mouse to click on this space and type in a new name. When you are finished entering the name of the mark, click on the OK button, or press the return or enter key on your keyboard. If you decide you don’t want to set the mark, use your mouse to click on the Cancel button in the dialog box.

Go To

After you have set a mark in a run of the simulation, you can restore the run of the simulation to the state it was in when you set the mark. Move the cursor over the Marks menu, press the mouse button and drag the cursor down until “Go To” is highlighted, but don’t release it yet. Now, drag the cursor to the right until you can see the names of the marks. Drag down until the mark name you want is highlighted, then release the mouse button.

Before the program goes to the mark, it will ask you whether you want to save the current state of the simulation (the state before you go to the mark).

If you click on the Save button, it is the same as placing a mark at the current state of the simulation before going to the mark. In fact, the mark it places is called “Current state at:n”, where n is the number of the current time before the simulation goes to the mark. The current state mark will show up in the “Go to” and “Remove” lists, so you can treat it like any other mark. Type a new name for this current state mark, if you want. Click on the OK button.

The program will go to the mark you requested.
Remove

If you decide you no longer need a mark that you have previously set, you can remove the mark. Move the cursor over the Marks menu, press the mouse button and drag the cursor down until “Remove” is highlighted, but don’t release it yet. Now, drag the cursor to the right until you can see the names of the marks. Drag down until the mark name you want is highlighted, then release the mouse button. A window will appear, asking you to confirm that you want to remove the mark. If not, click on the Cancel button. Otherwise, click on the Remove button. The mark you selected will be removed.

Notes

After you have set a mark in a run of the simulation, you can enter a note to keep track of some information about the mark. Move the cursor over the Marks menu, press the mouse button and drag the cursor down until “Notes” is highlighted, but don’t release it yet. Now, drag the cursor to the right until you can see the names of the marks. Drag down until the name of the mark you want is highlighted, then release the mouse button.

A text window will appear. The window will contain any previously entered notes for this particular mark. It will be empty if no notes have were previously entered. You may use the standard Macintosh methods for typing and editing text, including cut, copy, and paste.

Windows Menu

All the commands under the Windows menu, with the exception of the “Tile Windows” command, display Epidemiology windows. Choosing a command from the Windows menu causes the window to appear if it is not already being shown, and to become the active window.

The “Tile Windows” command will re-size and reorganize Epidemiology’s open windows so that they do not overlap each other.
Status

The “Status” window displays the current time and the number of individuals in the total population and in each category. It also indicates whether the simulation is currently running or is stopped. When the simulation is running, the status window is updated each display interval. You cannot change the values in this window directly. To change the current numbers in any category, choose “Current State...” from the Settings menu.

You can select the categories that will be displayed by choosing “Display Settings...” from the Settings menu and checking the appropriate boxes in the "Display Settings" dialog box. The following are the values that can be displayed in this window:

To see the Status window if it is not already shown, choose the “Host Status” command from the Windows menu.

The Flow Chart

The population characteristics that influence population growth and the spread of a disease in the population are summarized in graphical form in the flow chart window. The flow chart gives a graphical depiction of the way that the models underlying Epidemiology work. The host population is broken down into several categories. In the flow chart depicted above, for example, the categories are “Susceptible”, “Infected”, "Asymptomatic - Infected”, "Symptomatic - Infected", "Recovered", "Immunized", "Uninfected", "Natural Deaths", and "Disease Deaths".
and “Recovered”. In this case, “infected” implies infectious, and “recovered” implies immune to further infection.

Values for factors such as the birth rates, death rates, disease transmission rates, rates of recovery, etc. can be viewed and/or changed by clicking on the appropriate button on the flow chart. For example, holding the mouse button down on the icon on the arrow next to “birth rate” brings up a pop-up menu indicating the current setting of the birth rate, and providing several other choices. If you wish to enter a value other than those available from the menu, select the custom option, which will bring up a dialog box allowing you to type in a value. You can change these values at any time, even when the simulation is running.

**Population Size vs. Time**

This window displays the number (or proportion) of individuals in different population categories through time. When the population gets large, the population values on the y-axis will be expressed in scientific notation, for example: 5.00 e+ 07 (which represents 5 times 10 to the 7th power, or 50,000,000).

To change from total numbers to proportions (or back again), click on the “%” icon on the tool bar at the top of the window.

The display can either be in a graphical form or in tabular form. To switch from one to the other, click on the table or graph icon in the tool bar above the graph.

The values displayed are calculated from other population values; you cannot change this window directly. You may alter the current population sizes by choosing “Current State...” from the Settings menu and entering the value that you want into the appropriate field of the dialog box.
To see this window, if it is not already shown, choose the “Host Pop Size vs. Time” command from the Windows menu.

**Deaths vs. Time**

This window displays the number (or proportion) of individuals in the population that died during each time interval. It displays both the number of “natural” deaths, and the number dying from the disease. When populations are very large, these values will be expressed in scientific notation, for example: 5.00 e+07 (which represents 5 times 10 to the 7th power, or 50,000,000).

To change from total numbers to proportions (or back again), click on the “%” icon on the tool bar at the top of the window.

The display can either be in a graphical form or in tabular form. To switch from one to the other, click on the table or graph icon in the tool bar above the graph.

The values displayed are calculated from other population values; you cannot change the values in this window directly.

To see this window, if it is not already shown, choose the “Host Deaths vs. Time” command from the Windows menu.
Glossary

Below are some of the key terms used in Epidemiology and in this manual:

**Asymptomatic:** Individuals who have been infected but who do not yet show any signs of the disease.

**Birth rate:** The number of births per individual in the population during a specified time interval.

**Death Rate:** The fraction of the population that dies during a specified time interval.

**Density dependent:** A factor that changes values depending on the density of the host population. In Epidemiology 2.1, the user may set the contact rate (average number of contacts per individual per time interval) to be density-dependent or density-independent.

**Disease Death Rate:** The fraction of the population that dies during a specified time due to the disease.

**Doubling Time:** The time it would take a population to double, given no changes in age-specific mortality or fertility rates. Any change in the fertility or the mortality graphs will result in a change in doubling time.

**Duration of infection** -- This is the average number of time units that an individual remains infected before moving into the recovered category (provided, of course, that he/she doesn't die!).

**Immunity Loss:** A measure of the rate at which individuals who have recovered from the disease or who have been immunized lose their immunity and become susceptible to infection again. In age-structured models, this rate can depend on age.

**Immunization rate** -- This is the proportion of newborns that are vaccinated. Right now, the program makes the unrealistic assumption that vaccinated individuals remain immune for life. To start out, set this to 0.

**Latent:** Individuals are in a latent state when they have been infected, but are not yet showing symptoms, and are not yet infectious.

**Natural (or Background) Death Rate:** The fraction of the population that dies during a specified time interval due to causes other than the disease.

**Probability of transmission:** The probability that a susceptible individual will become infected in a particular contact with an infectious individual. This value must be between zero and one.
**Recovery Rate:** The rate at which infected individuals recover from the infection and become immune. In age-structured models, this rate can depend on age.

**Reservoir Populations:** Populations of species (other than the host) can harbor the disease-causing organism (e.g., rats harbor plague; many mammals and birds harbor lyme disease). Of course, from the point of view of rats, humans are a reservoir of plague.

**Symptomatic:** Infected individuals who show signs of having the disease.

**Vector Populations:** Populations that transmit disease-causing organisms from one host individual to another (e.g., mosquitoes, fleas).
Appendix 1: Hardware and Software Requirements

*Epidemiology* is designed to operate best on the Macintosh II family of computers or on Power Macintoshes. However, it will run nicely (though slower on lower end models) on Macintoshes of any type, so long as at least 1 megabyte is available to the program (However, for a large run with many marks, it may be necessary to set the partition size for *Epidemiology* to more than 1 megabyte — Choose Get Info from the Finder). In order to run the program, you only need to have the application itself. All of the resources that the program requires are already installed in the application. Of course, if you have saved an experiment and want to open it, you will need to have the file into which you saved that experiment. *Epidemiology 2.5* is System 7 and MacOS 8 compatible and is accelerated for PowerPC’s.

**Summary of Hardware and Software Requirements**

- Macintosh computer with at least 1 megabyte of available random access memory (RAM).
- Macintosh operating system 6.x or greater is required. However, system 7.x or OS 8 is recommended
- *Epidemiology 2.5* is accelerated for running on computers with PowerPC microprocessors. Three versions of the program are available: a 68K version (which will run in emulation mode on PowerPC computers, a PowerPC only version, and a “fat binary” version which automatically run the version of the application best suited to your computer.
- *Epidemiology* application installed on the hard disk.
- On a color monitor, the graphs will be displayed in color. On a monochrome monitor, the graphs will be displayed with different patterns.
Appendix 2: It Doesn’t Work!

Even the best program has some bugs in it. However, there are many situations in which there is some other problem, something that is not an error at all.

I can’t open the program

If Epidemiology reports an insufficient memory error during startup, the problem may be that there is not enough memory. Are you sure the machine has at least 1 megabyte of free (RAM) memory? Are you running other applications (under MultiFinder) which can be closed?

First, find out how much memory you have: Under the Apple () menu, select “About Finder...”. In System 7 this is called “About This Macintosh...”. You will see a dialog box detailing the current memory usage in your system. The crucial figure is the Largest Unused Block. This value must be over 1000K in order for the system to run. If it is not, and there are no other applications currently running, then Epidemiology can not be run on that machine. If there are other applications currently running, try quitting those applications in order to free up memory.

I can’t open a Epidemiology document.

Was the document created with an early version (1.x, 2.1) of Epidemiology? Epidemiology 2.5 will not open documents created with earlier versions.

I get an error message when I try to set a mark.

If Epidemiology reports an insufficient memory error when you are attempting to create a new mark, the problem may be that there is not enough memory for the requested operation. Try removing unused marks, then save the file. If there are other applications currently running, try quitting those applications in order to free up memory.

I’m having trouble setting my graphs

Make sure you click on the window first, to make it the active window. Check to see that the cursor turns from an arrow to a cross shape when you position it over the graph. Click on the graph at the point you want to set, or hold down the mouse button and drag the graph into the shape you want.
Appendix 3: Notes for Instructors

In this section we provide some suggestions for instructors on how to use Epidemiology in the classroom and laboratory. First we describe a series of activities used in a freshman seminar class at the University of Oregon (Appendix 4: A Sample Learning Module contains the packet of materials that we handed out to our students). Instructors should feel free to modify these materials to suit their needs. We then describe how instructors can take advantage of some of Epidemiology's features to help prepare learning materials.

Note that Winter 1996 was the first term in which these exercises were tried. The learning module should definitely be considered a rough draft!

The Simple SIR Model

The simple models used in Epidemiology 2.5 are all variants of the mathematical model for the spread of an infectious disease caused by a microparasitic agent as described in Chapter 6 in Anderson & May (1991). This model is generally referred to as an SIR model because it tracks the number of Susceptible, Infected and Recovered individuals in a host population. The system of equations appears below:

\[
\begin{align*}
\frac{dX}{dt} &= \text{birthRate} \times N(t) - (\text{deathRate} + \text{transmissionRate} \times Y(t)) \times X(t) \\
\frac{dY}{dt} &= \text{transmissionRate} \times Y(t) \times X(t) - (\text{mortalityRate} + \text{diseaseDeathRate} + \text{recoveryRate}) \times Y(t) \\
\frac{dZ}{dt} &= \text{recoveryRate} \times Y(t) - (\text{deathRate} + \text{lossOfImmunityRate}) \times Z(t)
\end{align*}
\]

where,

\(X(t)\) = the susceptible population at time \(t\)
\(Y(t)\) = the infected population at time \(t\)
\(Z(t)\) = the recovered population at time \(t\)
\(N(t)\) = the total population at time \(t\)

Our models are discrete-time versions, with the number of iterations per time interval under user control. The variants of our simple model differ in the way that they calculate the transmission rate, and in the number of additional population variables that they track.

How we use Epidemiology at the University of Oregon

The learning module in Appendix 4 was designed for use in introductory classes for non-majors. The first half of the module was tried out in Winter 1996 by Dan Udovic in a freshman seminar. By the time students used the learning module in the seminar, they had been learning (in a very non-technical way) about the spread of infectious diseases for several weeks. They had been reading and discussing Laurie Garrett’s *The Coming Plague*, and had seen videos on the eradication of smallpox and on issues surrounding the use of polio vaccines.

To learn more about this course and the resources used, you may want to check out the class World Wide Web site (http://biology.uoregon.edu/classes/bi199/home.html)

Before introducing the students to the computer program, you might consider either or both of the following activities to lay the groundwork. For more advanced biology majors these activities may not be important. For most non-majors, however, the activities prepare them for the computer exercises which follow.

The first is a simple hands-on classroom simulation activity that illustrates how an infectious disease spreads. The general idea is that one or two students in a class are somehow “infected” and infect other students through a series of contacts. No one knows which students were infected originally, so the problem is for the class to try to deduce the index case(s) from information that they collect about their contacts. There are many variants of this exercise, but a simple, effective, and fun lab exercise is described by Dickey (1989; American Biology Teacher 51(6) 364-365). The whole exercise can be done in 30-40 minutes. Once the exercise is complete, the instructor can work with the class as a whole and develop a graph of the number of susceptible and infected individuals through time.

A second preparatory activity is to have students (working in groups) develop a flow chart or concept map describing the relationships between factors that influence the spread of a disease. Butcher paper, magic markers and post-its can be provided as materials. Finished diagrams can be presented to the whole class for discussion. If students have worked on their diagrams individually (e.g., as a homework assignment before class) they will be prepared to make more rapid progress as a group. Their diagrams can form the springboard for a discussion of various proximate and ultimate causes of disease outbreaks, and for an introduction to the flow chart models used in *Epidemiology*.

The *Epidemiology* exercises move from simple and highly structured to more complex and open-ended. We encourage this approach, since it eases students into the program, building both confidence and understanding. If your students have had little experience using computers in your class, even our “simple” initial exercise is likely to cause some frustrations. In such circumstances, we would recommend that you construct a few brief preliminary and highly directed exercises that will insure that all students feel comfortable with the program and the material.

As we help students through the structured exercises, we try to avoid “leading” students to the “right answer”. Rather, we try to help them understand their
observations, clarify their thinking, and design good experiments. Furthermore, whenever possible, we have students take the time to think about what they expect to happen (usually in small groups), to write down predictions, and to explain the basis for their predictions. Often comparing the results that they obtain with their predictions leads to cognitive dissonance which can be very useful in the learning process.

Initially some students may feel that this is a glorified game of “hide and seek” (in a sense it is). In addition, though, it is essential practice for open-ended investigations, and the interaction between faculty and student is much more rewarding than when guiding students through prescribed steps that lead to the “correct answer”. Students develop a deeper understanding of the concepts and gain important skills in designing and performing experiments, and faculty gain important insights regarding student knowledge and misconceptions.

The activities in Appendix 4 introduce students to the following concepts:

• building and analyzing population models, including construction of flow charts, mapping out “parameter space”, and testing the sensitivity of the model to certain parameters,

• why interactions between host populations and pathogen or parasite populations often lead to population cycles,

• how the virulence of a disease agent and its mode of transmission interact to influence whether a disease will spread in a population,

• how immunization rates can affect the spread of a disease, perhaps leading to a disease dying out even if the percentage of the population immunized is much less than 100%,

• why a threshold population density is necessary for the spread of some diseases, and what factors influence the level of that threshold.

Open-ended Investigations with Epidemiology 2.1

Appendix 4 does not include a truly open-ended investigation. Once students have worked through those activities, however, they will be ready to use Epidemiology to build and analyze models of particular diseases of their own choosing. They might be asked to find literature and materials on the Internet to help them decide how to build their model and what values to use for various parameters. Does their disease have a latent period, or an asymptomatic infectious stage? How is it transmitted, and what are the probabilities of transmission? And so on. They could be looking at diseases of humans, or of other animals, or even plants. Based on their findings, they could be asked to prepare a report for the class. Combining these modeling activities with a more complete study of a disease, including elements such as the impact of a disease in human history, related scientific discoveries, such as treatments or vaccines, and their associated controversies, could make an excellent term-long project. In the terminology of the BioQUEST Consortium, students would be posing their own problems, investigating possible solutions, and, in their classroom presentations, persuading their peers.
Using Epidemiology's Features to Prepare Learning Materials.

Epidemiology can be used to create custom files for problem sets, exams, or classroom demonstrations. The steps involved in creating custom files (changing parameters and settings, marking, saving files) are no different than those to use the program, and hence all of the relevant program features are described in the manual. Here we provide a few pointers that you might find useful.

Setting marks can be a powerful tool in creating presentations and problem sets. Marks allow you to set parameter values exactly the way that you want them, position and size windows to suit your needs, give those settings an appropriate name, and add comments in the associated “Notes” window. By setting up several marks in the same file, you can quickly move from mark to mark in a presentation, using each mark to set up a simulation demonstrating a different point, or using two or more marks to make comparisons.

When setting up problem sets for students, it may be better to create a number of files with only one or two marks per file, rather than a single file with numerous marks. The problem is that in the current version of the program, there is no mechanism for grouping related marks. If students choose to set marks of their own, the latter approach would lead to a single file with a collection of marks that are difficult to keep organized.

Once you have created a file and set up all the marks that you need, you may save the file using the SAVE or SAVE AS... commands under the File menu. Epidemiology will save all the initial values, including model type, and all the values displayed on the graphs for each mark that you set, information about these marks (such as the name and the notes that you entered for each mark), and display information for each window (such as the position and size of each window, and whether or not it is open or closed).

If you discover that you want to edit a file, marks can always be added or deleted. In the current version of Epidemiology, individual marks cannot be edited. If you wish to change the settings for a particular mark (e.g., re-position some of the windows), you will need to go to that mark, make the desired changes, create a new mark, and then delete the old one.

Epidemiology and associated files are standard Macintosh files, and can be copied in the usual ways when you are in the Finder (for example, by choosing the Finder’s Duplicate command from the File menu, or by dragging the file from one disk to another). You will probably want to copy each of the files you have prepared onto a floppy disk that each student will use, or copy the files onto each computer’s hard drive.
Appendix 4: Modeling the Spread of a Disease - A Sample Learning Module

Note: The Introduction and Exercise 1 of this Appendix can also be found in a slightly different form in the file called "Modeling Diseases".

Introduction

When a new disease enters a population, we can envision several different kinds of outcomes: (1) the disease could quickly die out, (2) the disease could remain in the population at more or less stable levels, perhaps “settling down” after a major outbreak (i.e., become endemic), (3) the disease could cycle in incidence, causing periodic epidemics (the cycles could increase or decrease in amplitude, or remain about the same), (4) epidemics could come and go at more or less random intervals, perhaps exhibiting “chaotic” behavior, or (5) the disease could cause the population to go extinct.

Which of these outcomes can we expect from diseases like AIDS or Ebola? Examining simulation models may give us some insights. We might also learn something about the factors that influence the severity of epidemics, or the levels of endemism. Finally, models may help us understand the impact of public health policies and practices.

How would we go about building a model of the spread of a disease? One important step is to identify the variables that we want to track through time. For example, a demographer tracks the size of populations through time, perhaps divided into population categories, such as gender groups, racial/ethnic groups, or age groups. To track changes in population size, we must look at the processes that could bring about change. In this simple case, there are only three things that can happen (1) individuals can come into the population via birth or immigration, (2) they can leave the population through death or emigration, or (3) they can move from one category to another (e.g., by getting older, or by having a sex change operation, or by changing their economic status). That’s it! So if we could model the processes by which the number of individuals in each category change, then we could make predictions about the future state of the population. Of course, the challenge is to figure out what influences birth rates, death rates, etc., and that may be very hard, especially when all of the influencing factors may interact in complex ways.

In the case of epidemiological models, the population variables can be divided into individuals that are susceptible to infection, those that are infected currently, and those that have recovered (assuming that these individuals are now immune to infection). This is the simplest view, and is the basis for the so-called SIR models. Of course, in more complex models, each of these categories could be divided by gender, age, socioeconomic status, etc. But to start with, let’s keep it simple. Other complications could include the size of reservoir populations, intermediate host populations, or vector populations. Let’s concentrate now on a simple disease, like smallpox, that is transmitted only from individual to individual, and which seems to be an “affirmative
action” disease, showing no gender, age or social preferences. Once we understand aspects of this simple model, we can consider how various complications might affect our results.

The computer program that we will be using (Epidemiology) allows you to control factors such as the probability of infection, the death rate due to a disease, the proportion of a population vaccinated, and the average length of infection, so that you can study the way these factors interact to influence the spread of a disease.

The next few pages introduce you to the computer program. They are followed by some questions to help guide your explorations.

Using Epidemiology 2.1

The Flow Chart

The flow chart describes the model of disease transmission in graphical form. Individuals in the population belong to one of four categories. They are either susceptible to infection, infected, recovered (and immune to further infection) or they are immunized. The arrows in the flow chart show how individuals enter and leave these categories. For the disease graphed here, all individuals are born susceptible. They stay in that category unless they become infected or they die (from causes other than the disease).

Clicking on the little icons (buttons) in the flow chart brings up dialog boxes that allow you to change the rates at which individuals enter or leave each of the four population categories. For example, clicking on the button on the arrow going from susceptible to recovered brings up the following dialog box:
Increasing the value of either the probability of transmission or the contact rate (average number of contacts per time interval) will increase the rate at which susceptible individuals become infected. Please ignore the rest of the dialog box for the time being.

**Make sure that you understand what each of the icons represents.** The only ones that require special explanation are the death rate icons. One represents the “background” death rate due to causes *other than the disease*. This rate is the same for individuals in all four categories. The other represents the death rate resulting specifically from the disease. It applies only to individuals in the “infected” category.
The population window tracks the number of individuals in a population through time in each of the three categories: susceptible, infected, and recovered.

Describe in words what happened to this population from time 0 to time 50.

Two buttons at the top of the population window provide viewing options:

- Allows you to toggle back and forth from looking at population sizes to looking at percentages.

- Allows you to switch back and forth from a graphical to tabular view. Graphs give you a good overview of trends, but if you want to know the actual values at specific times, then choose the table view.

Another box at the top of the window shows the current x,y coordinates of the cursor when it is within the region of the graph. You can use this feature to find a close approximation of a given variable without switching to a tabular view.
The Status Window

The status window shows the population sizes (or proportions) at the current time interval. It also shows you whether the simulation is running or is currently stopped.

The Control Panel

The control panel works in much the same way that control buttons on a CD player or VCR work.

This is the **Stop** button. When the simulation is running, press this button when you are ready to stop it.

This is the **Go** button. Click on this button when you want to run the simulation. It will continue to run until you stop it. (For greater control over the amount of time that a simulation runs, choose “Go Until...” or “Go For...” from the “Control” Menu.

This is the **Step** button. Click on this button to run the simulation for one time interval. Since the simulation model runs quite fast (especially on Power Macs), stepping can be useful if you want to watch the progress of the simulation more carefully.

This is the **Reset** button. It will reset the time to 0, and the population sizes to their original values. It does not change the parameters that are set via the flow chart.
Setting Up the Model

The simple model that we will be exploring allows you to set values for the following factors:

**Birth rates** -- You enter the number of individuals born, per individual in the population, per time unit. For example, if the time unit is years, and we are dealing with a human population that has a birth rate of 20/1000 per year, you would enter 0.02.

**Death rates** -- You enter the number of individuals dying, per individual in the population, per time unit. For example, if the time unit is years, and we are dealing with a human population that has a death rate of 10/1000 per year, you would enter 0.01. This is a "background" death rate due to factors other than the disease.

**Disease death rate** -- You enter the proportion of the infected population that dies of the disease each time interval. For a disease such as the common cold, this would be 0.0. For a disease like smallpox it might be something like 0.25.

**Number of contacts per time interval or Contact Rate**-- How many contacts (of the sort that might result in transmission) does an individual make with other individuals during the course of a time interval, on average? This will depend on how the disease is transmitted and the nature of living conditions. For example, the value would be much lower for an STD than for the common cold. It would also be lower in a rural area than in an urban area. Try 100 to start out with.

**Probability of transmission** -- Given a contact between a susceptible individual and an infectious individual, what is the probability that the susceptible individual will become infected? Values entered must be below 1. Something like 0.01 might be reasonable to start with.

**Duration of infection** -- This is the average number of time units that an individual remains infected before moving into the recovered category (provided, of course, that he/she doesn’t die!). Try a value of 3 to start out with.

**Immunity loss** -- This is the average length of time that a recovered individual remains immune to further infection. When individuals lose their immunity, the move from the recovered category to the susceptible category.

**Immunization rate** -- This is the proportion of newborns that are vaccinated. Right now, the program makes the unrealistic assumption that vaccinated individuals remain immune for life. To start out, set this to 0.

Now that you have entered these settings, go ahead and run the simulation. Let it run for about 50 time intervals. Examine and interpret the resulting population graphs. Did anything unexpected happen?
Posing a Question/ Making a Prediction

Working with your partner, choose one of the factors from the previous page, and make a prediction about how you expect the outcome of the simulation to change if you change that factor.

Which factor did you pick? _________________________________

What is your prediction? (If I increase/decrease the value of ____, I expect...)

Now make the change and run the simulation. Describe the outcome of the simulation and how it compares with your predictions.

What hypotheses can you come up with that might explain the differences between the expected and the actual outcomes?
Exercise 1. Investigating Virulence and Ease of Transmission

We will concentrate our modeling efforts in this exercise on examining how the virulence of the disease agent (how deadly it is) and its ease of transmission affect its spread. We should be able to use our results to help assess the potential threats of newly emerging diseases like Lassa Fever and Ebola.

The approach that we will take is to systematically explore "parameter space", seeing what happens for different combinations of parameter values. Since we will start by just examining two parameters, we will need to choose values for the other parameters, and keep those constant. We'll use the values that we had when we initially started the program.

The first thing you should do is to make some predictions about what you expect to happen. The graph below shows a hypothetical (and probably nonsensical) “mapping” of parameter space. In the “empty” graph on the next page, you should generate your own “mapping”, and explain your predictions.

The drawing above shows a hypothetical mapping of parameter space. To interpret the map, notice that it is divided into four regions. This map, for example, predicts that when transmission rates are low and virulence rates are low (i.e., the disease is not very
deadly), the disease should die out. There is no basis for the predictions made here. It is just a hypothetical example.

Your Predictions:

Use the graph above to map out your predictions. Give the rationale for your predictions below.

Your Rationale:
Once we’ve all thought about and written down our expectations, we can start our experiment. Basically, we need to fill in a chart similar to the graph above. Rather than all of us doing all of the simulations, we can divide up the workload and collate all our results.

<table>
<thead>
<tr>
<th>Death rate-Transmission</th>
<th>Very Low 0.0</th>
<th>Low 0.1</th>
<th>Medium 0.2</th>
<th>High 0.3</th>
<th>Very High 0.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very Low 0.001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low 0.005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medium 0.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High 0.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Very High 0.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

It may, of course, take more room to explain the outcome of each run. As a class, when we look at the different results, we can decide what it is that we think is important, and what is not so important. We will discuss this as we go along.

Once we have collated all our results, each of you should compare your results with your predictions and attempt to explain what we have observed. Fill in the graph on the next page. Are there major surprises?
<table>
<thead>
<tr>
<th>Low</th>
<th>Med</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Med</td>
<td>High</td>
</tr>
</tbody>
</table>

Class Results:

VIRULENCE

N S I T S R A M O L
Exercise 2. How would immunization affect these results?

Make and test predictions about how the pattern of outcomes observed above might change for different levels of immunization or for different durations of infection. Use the space below to describe your predictions, to show your results, and to draw some conclusions.

(NOTE: To set up Epidemiology to allow for immunizations, choose “Define Model...” from the Settings menu. In the Model Definition dialog box, enable immunization by clicking the check box next to it. Then click OK. A new set of windows will appear, with a new flow chart that includes a category for immunized individuals.)
Exercise 3. Initial Population Sizes

One of the more interesting results from epidemiological modeling has to do with the way the size of a population influences the ability of a disease to spread. In the this exercise, we will examine this relationship by exploring what happens when we start out with populations of different sizes.

In the previous exercise, the model that we used assumed that the average number of contacts per individual did not change with population size. For many diseases, this will not be the case. Contacts will increase with the density of the population. Building a more realistic model that allows for this could have a dramatic impact on our results.

Can you explain why this might be?

We will divide the class into four different groups. Each group will do a similar set of simulation runs, mapping out an area of “parameter space”, but the groups will differ slightly in the models they use or in the parameters they explore:

<table>
<thead>
<tr>
<th>Model Type</th>
<th>Parameters -&gt;</th>
<th>Init. Pop. Size vs. Virulence</th>
<th>Init. Pop. Size vs. Prob. of Transmission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density-Independent Contact Rate</td>
<td>Group 1</td>
<td></td>
<td>Group 2</td>
</tr>
<tr>
<td>Density Dependent Contact Rate</td>
<td>Group 3</td>
<td></td>
<td>Group 4</td>
</tr>
</tbody>
</table>

On the graph on the next page, map out your predictions for the simulations that your group will do. In your explanation, discuss how your predictions would differ if you were using the opposite model.
Your Predictions:

Explain your predictions:
Once you’ve made your predictions, you can go ahead and start doing some simulations, with the object being to fill in the table below (similar to the previous exercise). Once again you may divide up the work among you.

Groups 1 and 3 should use a fixed probability of transmission of 0.01, and groups 2 and 4 should use a fixed disease death rate of 0.2. For the varying parameter, use the values from the table in exercise 1.

Be careful to let your simulations run for a long enough time to be sure that you know what will happen. Sometimes the results may surprise you. For example, sometimes, just when a disease looks like it has died out or will die out, an epidemic can break out.

<table>
<thead>
<tr>
<th>Death rate -&gt;</th>
<th>Very Low</th>
<th>Low</th>
<th>Medium</th>
<th>High</th>
<th>Very High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prob. of</td>
<td>0.0</td>
<td>0.1</td>
<td>0.2</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Transmission</td>
<td>0.001</td>
<td>0.005</td>
<td>0.01</td>
<td>0.1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Initial Pop Size (Susc)</th>
<th>Very Low</th>
<th>Low</th>
<th>Medium</th>
<th>High</th>
<th>Very High</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1000</td>
<td>10,000</td>
<td>25,000</td>
<td>50,000</td>
<td>200,000</td>
</tr>
</tbody>
</table>

Use the space below to summarize the findings of the class. Be sure to compare the density-independent and density-dependent models, and be sure to describe both the interaction between population size (or density) and probability of transmission and the
interaction between population size and virulence. How did the results compare with your predictions.

What general conclusions can we draw from our results?
**Discussion Questions**

Based on our explorations with *Epidemiology*, here are some questions to consider:

1. Does Ebola pose a serious threat to human civilization? How do the lessons learned from our simulation modeling relate to this question?

2. Some biologists and historians argue that many infectious diseases, such as the bubonic plague, measles, malaria, were only able to become epidemic after the human congregations in villages and cities reached large enough numbers. Based on your experimental results, do you see any theoretical validity to this view? If so, rank malaria, measles and plague with regard to the threshold sizes you think would be necessary to sustain them. Explain your rankings (i.e., what characteristics of these diseases did you use to distinguish them?). Look up the timings of the origins of these diseases to see if they are consistent with your predictions.

3. How do the lessons learned from these simulation exercises relate to the co-evolution between hosts and disease-causing organisms?

4. Public Health experts often claim that immunization rates much less than 100% can be satisfactory to cause a disease to die out in a given area. Do our results lend any theoretical validity to these arguments?
Index

A
Acknowledgments, 3
AIDS, 10, 36
Asymptomatic, 28

B
Biology Software Lab, 1, 4
birth rate, 28, 41
bubonic plague, 52

C
concept map, 33
contact rate, 28, 38, 41
density-dependent, 48
Control menu
  Go, 12, 20, 21, 40
  Go For..., 12, 20
  Go Until..., 12, 19
  Reset, 18, 21, 40
  Reset All..., 18, 21
  Show/Hide Control Panel, 12, 21
  Step, 12, 20, 21, 40
  Stop, 12, 21, 40
Control Panel, 11, 12, 21, 40

dead, 28, 41
disease, 8, 28, 41
  natural, 8, 28
density dependent, 9, 28
density independent, 9, 28
disease introduction, 9
diseases
  airborne, 9
  sexually transmitted, 9
doubling time, 28
duration of infection, 28, 41

E
Ebola, 1, 4, 36, 43, 52
Edit menu
  Clear, 19
  Copy, 18
  Cut, 18
  Paste, 19
  Show/Hide Clipboard, 19
  Undo, 18
exporting, 14

F
File menu
  Close, 16
  New, 16
  Open, 7, 14, 16
  Page Setup..., 17
  Print, 14, 17
  Print Setup..., 14
  Quit, 15, 18
  Save, 14, 17
  Save As..., 14, 17
fleas, 11, 29

G
goals, 1
graph icon, 13
graphs
  switching from tables, 13
  switching to, 26, 27

H
hardware requirements, 30
Hot Zone, The, 1

I
immunity loss, 28, 41
immunization rate, 28, 41
influenza, 9, 10
initial values, 22
instructors, 1, 32

L
Lassa Fever, 43
latent, 10, 28
lyme disease, 29

M
Macintosh
  operating system, 30
Macintosh basics
  clicking, 6
  double-clicking, 6
  dragging, 6
  Pointing, 6
  selecting, 6
malaria, 52
marks
  notes, 18, 19, 24, 35
  setting, 13
2 Epidemiology User's Manual

Marks menu
- Go To, 23
- Notes, 24
- Remove, 23, 24
- Set..., 23
measles, 9, 52
menu
- Settings, 10, 11, 13, 22, 25, 26
menus
- Control, 11, 12, 18, 19, 20, 21
- Edit, 18, 19
- File, 7, 14, 16, 17, 18, 35
- Marks, 18, 19, 23, 24
- Windows, 24, 25, 27
microprocessor
- 68K, 30
- PowerPC, 30
model settings, 10
model types, 10, 22
models
- simple, 32
mortality
- age-specific, 28
mosquitoes, 11, 29

O
open-ended investigation, 1, 34
Outbreak, 1

P
plague, 11, 29
population categories
- latent, 28
population categories, 25
- immunized, 37
- infected, 1, 7, 10, 22, 25, 32, 36, 37
- recovered, 1, 7, 8, 10, 22, 26, 32, 36, 37
- susceptible, 1, 7, 8, 10, 11, 22, 25, 28, 32, 33, 36, 37, 38, 39, 41
probability of transmission, 9, 28, 38, 41, 48
problems, 31
public health policies, 52

Q
quitting, 15

R
rats, 29
reservoir populations, 10, 11, 12, 29

S
saving, 14
scientific notation, 26
Settings menu
- Current State..., 9, 22, 25, 26
- Define Model..., 10, 22
- Display Settings..., 25
- Display..., 13, 22
- Fonts, 23
- Model, 22
SIR models, 1, 32, 36
smallpox, 36
summary statistics
- definitions, 25
symptomatic, 29

T
table icon, 13
tables
- switching to, 26, 27
threshold density, 48, 52
tool bar, 13, 26, 27

U
University of Oregon, 1, 2, 32, 33

V
vector populations, 11, 29
vectors, 10, 12
virulence, 48

W
windows
- Deaths vs. Time, 13, 27
- Flow Chart, 8, 25, 37
- Notes, 35
- Population Size vs. Time, 12, 14, 22, 26, 27, 39
- Status, 12, 22, 25, 40
- Tile Windows, 24
Windows menu, 24
Workshop Biology, 1, 3
World Wide Web, 2, 4, 33